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AEHRP AL %z’xﬁ%“%f G EL 1T SF T AL XEY Java
Fafrw B g ES > AF &5 FP Eclipse & = B % & 5 (Integrated
Development Environment, IDE) ~ Apache Tomcat # PR % ~ ZK % F & % ~ Java
B #A -~ f-JDBC 4 MySQL * 3 3% -

4.1 Eclipse IDE

A% %2 Java 4254 3F 7 i
AEEFIE

7 EE > % Eclipse Oxygen *< 4 1% 5

Eclipse #~ =t fxdepr » & LA - B = (Workspace) -
2t 4T AR AR R G I T & ¢ o &% & windows->preference T
java->Build Path->User Libraries » fiz ¥ Z 3 ¢ * 3| ek 38 2 (libraries) o iz 4t
S8R B W 2% Workspace B A1 ik k@ cho 4o 4.1 #1F o

?7}—' HiTs 1 ivd

& preferences O b4
| User Libraries - - -
C/C++ ” L .
ser libraries can be added to a Java Build path and bundle a number of externa
Cloud Eound User lib be added to a Java Build path and bund| ber of external
D; aunary 4 archives. System libraries will be added to the boot class path when launched.
Code Recommenders Defined user libraries:
Data Management
Gradle =, aws-java-sdk-1.11.475 - New._.
Help =, commons-beanutils-1.9.3
Install/Update =), commons-codec-1.10 Edit...
v Jlava =\ commaons-lang-2.6 ETIT
Appearance Bl commons-logging-1.1.1 i
~ Build Path B\ commans-logging-1.2 Add External JARs...
Classpath Varia ®\ gson-2.8.5 -
T T - =\ HmsKernel-0.0.4 remove
Code Coverage B\ httpcomponents-client-4.5.6
Code Style B, jackson-2.6 Up
Compiler = joda-time-2.10.1 -
Debug Bl legion_maodule_0.4.0 -
Editar Bl legion_maodule_0.5.1
Installed JREs =\ legion_module_0.6.7 Impart...
IUnit Bl legion_module_0.7.1 Export
Properties Files Edi Bl mysqgl-connector-java-5.1.44 el
Java EE B\ org.json-20130603
Java Persistence B\ UCanAccess-3.0.7
JavaScript B, zk-8.6.0.1
= B =), zk-ckeditor-3.5.2 v
'i?;' @:‘ Apply and Close Cancel
B 4. 1 Eclipse User Libraries
LEELBFERY CEF A NPT RES N EBISEP W EKP ¥
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7 & A java B F ié i# (Java Development Kit,
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&) Properties for EKP O *

type filter text Java Build Path MR
Java Build Path ~ ———
5 Java Code Style (® Source = Projects B Libraries % Order and Export ~
» Java Compiler JARs and class folders on the build path:
> Java Editor > B Apache Tomcat v8.0 [Apache Tomcat v8.0] Add JARs_.
Javadoc Location ] .
; » B\ commons-beanutils-1.9.3
» JavaSeript 5 Bk commons-lang-2.6 Add External JARs...
ISP Fragment » B commons-logging-1.2
Project Facets - o Add Variable...
! > B httpcomponents-client-4.5.6
Project R.efere.nces » =i JRE System Library [jdk1.8.0_181] Add Library...
Refactaring History 5 B, JUnit4
- h
EUHKDEbUQ Settings > Eh legion_module_0.7.1 Add Class Folder...
erver . .
Senvice Palicies ’ 'f*‘ mysgl—connector-]ava—SJ.M Add External Class Folder...
d Runti » ®h orgjson-20130603
Targete |_.|r1t|r'r1e~:. s B, zk-8.6.0.1 :
> T“t Repository » @ zk-CKEditor-3.5.2.0 =
Task Tags s @ tkext-8601 SR
> Validation , > B, zk-theme-8.6.0.1
Web Content Settings
Web Page Editor Migrate JAR File...
\Web Project Settings
< ' > - v

® Apply and Clase Cancel

B8] 4. 2 Eclipse Project Java Build Path

¥ebo 3 - B p & legion_module S E o (FE - B ARSGRE
# o AWS ~ LUIS ~ §- Google APl % e (% 4 & #4354 & > 3 EKP it % i
PR Bt LR AR o gt o B - B P 0T AL
JDBC it 8 ~ SQL 3% i iJZ ~ frokf % 3 P~ % 7 450 » 1548 legion_module &
PR

427K & F & %
EKP bz -1 e T 5 e 5V 3% PR F% o d 22 EKP 12 Java % 21 & eh
$oA23ET 0 57 {10 B html oo css FiE iAr 0 EKP % 3 F R H B F

2 Java i AP ZK 2 iF MVC e sh e TR 40 R ZK
F it T ZK CE B A7:18.6.0.1 5 & » 4] 4.3 “777 o

S ]

Download ZK Framework

Free Open Source Community Editlon v

@ ZK CE is open source and freely avallable

dar tha LGPL kcanae

(@ 2K 718 does not support IE 617, please download ZK 6.5 if hat's & requirement For a list of all browser support in ZK pleass click here

17y Installing ZK
Release Notes ./ Install ZK in your axisting enviconmant s
b Maven Archetype

fm Maven Dependencies =% Begin Tutorial

% OSGi Bundla W= Most fundamental features and concapts of ZK .>
7o ZK Sandbox
= W) Test your code online
Github

B 4.3ZK T T & (% ik * https://www.zkoss.org/download/zk[7])
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https://www.zkoss.org/download/zk

clipse |

import » _librares raw data »] zk-bin-8.6.0.1 » dist » lib

ZK s PE(% $3)fr EE(f £ 5R) 5 & { 5 * e iy > 270 30 I8 i %
o g CERALAF e T % ¢ I B zip#f - FREFE I zk-
bin-8.6.0.1->dist->lib FL & » AP F & Je LG 75 o jar fH % > FIE KRB
SR Y o e 4.4 Ao o in R A frvfI,%? M ARN Y 3l ZK R E e B
API -

| zeommaon jac
| zel jor

| htend jar

L =k jar

(&4 zkbind jar
(& =hplusjar
| &4 zhwabiragment jar
|} zul jar

| zweln jar

ot
theme

kdorge

Bl 4.4 ZK & 3% B3K 2

Za sl S GVERS > NP R A eclipse TRB AL IR ZK chF 5 o B F & 5
* ZK % Eclipse # & 4p ¥ & 9 IDE—ZK Studio - # Eclipse =7 Help->Eclipse
Marketplace # - ii%] » zk studio I #&F » % 3% ZK Studio 2.0.3 5x &~ - 4] 4.
5 #75% o

@) Eclipse Marketplace a X

Eclipse Marketplace

Select solutions to install. Press Install Now to proceed with installation.
Press the "more info” link to learn more about a solution.

Search Recent Popular Favorites Installed ) Eclipse Newsletter: Boot Build Eclips...

Find: |zk studic] & 4 | All Markets v -AIICutegories v | Go

=:e

ZK Studio 2.0.3.v201802141551

* MOTE: You have to use [Eclipse for J2EE] version or install [Web Tools Platform
p— (WTP)] first before you install ZK Studio. ZK Studio is a visual integrated... more info

by Potix Corp., Apache 2.0
Ajax Ul Construction ajax Framework docx web framework ...

¥ 46 l | Installs: 93.5K (512 last month) Instafled

Marketplaces

@ < Back Install Now > Finish Cancel

il 4.5 ZK Studio = {¢
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% %% ZKStudio & > # Eclipse e File->New i # ¢ >
¥ ZK Project v | & 4 % ZUL 5 & Preference :£ ¥ » # 12 ? 7

ZK % %o 4o 4.6 “T7 o

=

f 5] ZK 4p
149 4 J 21

P

B New

o % | M preferences o x
Select a wizard — type filter text K Dw v w
Properties Files Edi »
Jova EE Expand the tree to edit preferences for a specific feature.
Java Persistance
‘Wizards: JavaScrpt
‘ 150N
Maven
[ Plug-in Development -~ Myhyn
(= Remote System Explorer Oomph
&= Server Plug-in Development
[ SQL Development Remate Systems
[ Tasks Run/Debug
. Server
(= User Assistance
., Web Team
@ We Terminal
= Web Services
= XML
v = R
& IK Project
& zuL
Senices
ZK Account
7K Packages
ZUL Editar —
Restore Defaults
® S e [
£ [Aealy and Close] Cancel

4.3 Tomcat &R &

A% %3 * Tomcat8.0.46 5 & i JRE o & Tomcat i1 ¥ E & T
¢ & B s & chTomeat FIRE > 4oB) 4.7 477

(_

c O

Community

Search GO ‘

Apache Tomcat
Home
Taglibs
Maven Plugin

Schaol

Apache Tomcat®

Apache Tomcat

The Apache Tomcat® software is a
specifications are developed unde

The Apache Tomcat software is de

Download
Which version?
Tomcat 9
Tomecat 8
Tomcat 7
Tomcat Connectors
Tomcat Native
Taglibs

invite you to participate in this ope
Apache Tomcat software powers r
Apache Tomcat. Tomcat. Apache, t

Tomcat 8.5.37 Released

The Apache Tomcat Project is prou

Archives

versions remain unchanged. The r

] 4. 7 Apache Tomcat * §*

% (%% : http://tomcat.apache.org[8])

% Eclipse # &7 windows->preference->Server->Runtime Environment # >
dp LT 4T sk oh Tomeat Server B 5 > T dp T AE e <0 Java iE {7 B 5L (JRE) © 4

B 4.8 57 o



:@'PE‘ filter text Server Runtime Environments = v
 JavatE ) " Add, remove, or edit server runtime environments.
» Java Persistence
» JavaScript Server runtime environments:
+ JSON Name Type Add...
- Maven Ficraie iamen] Cesde e
. Mylyn pache Tomcat v8.0 pache Tomcat v8.0 Edit..
» Oomph
» Plug-in Development 8] £dit Server Runtime Environment m| x [Bemove
» Remote Systems i
» Run/Debug Tomcat Server Search...
o Specify the installation directory Eolumns.._
Launching
Overlays Name:
Profilers |!&pache Tomcat v8.0 I
| Runtime Environm: | Tomcat installation directory:
» Team P
. Terminal DAMyModule\tomcat\apache-tomcat-8.0.46 I Browse...
Validation apache-tomcat-8.0.36 | Download and Install...
» Web L
. Web Services RE:
» XML Workbench default JRE “ Installed JREs...
» ZK v 4
< > L
@ Cancel
® < Back Next > Cancel

B 4. 8 Tomcat 7 5 % 7

IS PREARER ALY ORT RS R BT ERERTPIRED -
4o 4.9 #7570 % Server cdi L (Perspective) T » i # new server > i k| k|
FE PR BE TR > L EKP & %51~ > g4k B#F EKP & ke
Tomcat TPPR‘E@;,J*I&’;H#;—E NI

Define a New Server
Choose the type of server to create
] New Server a x
Add and Remove
Select the server type: Maodify the resources that are configured on the server
| =
& Tomcatvd.1 Server ~ Move resources to the right to configure them on the server G-
H Tomcatvs.0 Server Available:
B Tomcatvs.5 Server _
H Tomcatv6.0 Server (5 HMS ZK
E Tomcat v7.0 Server » [ LegionModule Add >
Tomcat v8.0 Server
§ Tomcatva.s Server [
H Tomcatvo.0 Server < Remove L
> (= Basic *

Publishes and runs J2EE and Java EE Web projects and server configurations to a local
Tomcat server.

_Add All > >
Server's host name: |Ia:a|host |

Server name: |Tomcatv8.0 Server at localhost I

<< Remove All

Server runtime environment: | Apache Tomcat v8.0 v *dd,,

Configure runtime environments..

@ < Back Next > Finish Cancel

©) < Back Next > Cancel

Bl 4.9 2= = Application Server

AR PR A2 HNIK R K b PIRE > 4ok T 15 1] ZK
7g 2% e Hello World » 4] 4. 10 » iﬁfﬁ F2HRBEREAHT o
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&« C {t @ localhost:8080/EKP/

jith

b

Community Utility Google

Hello World!!

You are using:
86.01

B 4. 10 ZK Hello World
44Java i ¥ K

Aol EE EKP ehdava R B A § dieds o F AR RO
AR RFERL AEP FHIHRET TR T AR RE R EEER S
EaCE - SR R T At S R R L i e LR R
B it o

FEABOE o R~ FE A Java # 2 Ee ARV K Pl aT A

B il > 4ol 4. 11 5757 - PRE® A~ & K mgau; v LR E AR
oolg- BRED FEBENE 3‘-#1‘# °

1
o E—

2k controller

biz data
o - m +— h"'"“uul‘; . Dag My SgiDataSource
I Lk -
1

Wl 4. 11 Java % 1

4.5 MySql 74 &

A% %3 Java # 0 JDBC & 3% B 42 MySQL FH A » 7 2, Rl4c R
4. 12 #77 » Java J& * 4258 % 4 JDBC APl fr¥t i e85k 6 42.3¢ (driver) i it £
BirFREEE o 4340k v B8 (R * A RE > R EREAH D
driver ¥ » 28 2 R eedntg B ¥ 4 L o

JAVA APPLICATION
JDBCAPI

® 4.12 JDBC 7

10



EE R
ARP EKP #R* AR E AR (T o5l F AP FHAEH - 52%

P LUIS $i-3]°5.3 i — 5 38 & Java #25% ¢ v¥ v LUIS 3% ik e 2 PR3- (Web

Service) °
5.1 R H
*B R AREFA B E A J — BotMaster iF 5 %o B 2E 4 #&rﬂS 1 %757 o
T m #& ~ 3% ¢ (utterance)

F]iw#ZKEmL# 4 Iﬁ;ﬁprpm,,gwﬁ&
Bogied F;tL*izaLmLUIS TIEE E PR m&g](imemﬁra gé‘r
(entity) - BotMaster ¢ 7 — 3% 24+ 1 {5 i@ (threshold) > 4 3% & Bl e 5

EE B &@*ﬁﬁ#ﬁ%}'f@;m@p\ﬁcﬂ TR A ‘flﬁ-ﬁpﬂ

i o glﬂﬁ@‘”r
AL A H et AWS & Google APl e7pR 7% > B (s £ 3 B Feng & v @

B o

utterance

Consultant Bot Ul
LuIS
[ (Microsoft)
Intent -
entities -
S Database
response
Bot Master
adWws oy 2
J AP
W5 1EKP 5 48 % 4 % 4%
e 5% A Blents o) 0 g - BotMaster € v i * K ArinH LW
I W pE AT £ 378 % (publish)LUIS 23] -
Ak N - R E

PwEKP i3 #iEafaim > ¢ 7 @R

B HRLEEA R F R -

52 LUIS p #2E= 12 13
AagliE = LUIS stk 8515 » 7 2 & "Myapps | B 4% 4T [ Create new
app kAT HA] o 4B 5.2 #757 » T Engineer Knowledge | if #_EKP i * 3|

e LUIS #53] -
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Language Understanding Myapps Docs Pricing Support About

My Apps

I Create new app| T Import new app

earch app
[] Name Culture Created date Endpoint hits
| Engineer Knowledge (v 0.1 en-us 12/24/18 46

Travel Agent (v 0.1 en-us 12/11/18 9

B 5.2 2 LUISApp

B 2 fiie T ﬂJﬁé’%@SB%ﬁoiBMdéa’?u

T
Fﬁ?](lntents)fr*“" 8 (Entities) e P w AKX 23 SAIBI-1 AT -4 iz

FARSRET T A 07 “ﬂd" 2R o — B R R Z€ i xRl
m?&@‘ff‘?’{‘é s R WK RED B A oo

Engineer Knowledge (v 0.1) DASHBOARD BUILD MANAGE m

v App Assets

Intents -
| Intents
Entities
I+ Create new intent - Add prebuilt demain intent Search intents
Vv Improve app performance
] Name ~ Labeled Utterances
Review endpoint utterances
EK.Def 10
Phrase lists
EK.SearchDoc 7
Patterns
None 4
Bl 5.3LUIS 2 3 5
2 22 2 2% 3E > 44 = a1 2 - = A Y 2 D s
R T RISHE l—Traan BT 73 2 ?J"‘ﬁﬁ]’;;—q- FFE g “’?«‘F’ T v ?}’tl-m:}?* %R Bl r
W% o doW] 5.4 9T o

DASHECARD BUILD  MANAGE

Publish
: EK.Def # Detere tntent
tents
(] - -
[ utterance
v B DacType
+ ot EX.DocType
st 1+ EK.DocType
at s EXDocType
at « EK.DotType
vout EK.DocType
~st IK.DocType
25 EK DocType mess
e EK.DocType
rebul sen EX.DocType 0o EKDO<Type KDt 054

B 5.4 LUIS 2" 3 %
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5.3 Java = r! LUIS = i PR73(Web Service)

2 8 AR LUIS §90 3 o AL £ o AL @ BER

mE@pr

oAl st i

531:p = it

~E % m;;;aﬁﬁﬂ?&%ﬁ&* Java T S ¢ 5> 30§ Z & % Java £%
i [9]% % e APl 3Pl > 4o 5.5 #7om o
BT oo T RN E D

w1 LUIS mPRzZ» M dix e
TR RPRIEOFENE H o EH ¥ F 7

R AR EE

5.3.2 F ¥R 7%
EKP p =

(addUtterance) ~

§ TR B S L B

'? it e 5 B 157 ”Lr
(getintent) ~ = = & B (createlntent) LU F N
P15 (train) ~ ogF (publish)i%ﬁ PRF% > 4B 5.6 #77% o

ZEK B

B 5.5 LUISAPI z.p < &

% B (getAIIIntents)

v O Lu-isl:'rux}-'

a

a

=]

[ ]

*
o

authKey - String
appld : String
versionld - String
httpclient : HitpClient

endpmntURmelder' URIBuilder
LuisProxy(5tring, Strmg Strmg]

(understandlng) ~ AT

-

LI i e B

getAllintents() : Luisintent[]
getlnten‘c(Stnng} Luisintent
createlntent(JSOMNObject) - boolean
understanding(String) : LuisResult

addUtterance(AddUtteranceObj) : boolean

train() : boolean
publish() : boolean

BE|¢ © © © D © ©

parseLuisintent(JSONObject) : Luisintent

B 5.6 EKP ¢ i¥e1 LUIS API
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5.3.3 W { ArXH T HA

E lF“Ir@ﬁﬁagﬁ’ SESERE Y aud v ‘%’KK,__;J“; - BB g h
g 3¢ (function) & 2 & & FrenFfl & (dataset) - # P EH > WEF Y MER E
¥Rk r 8- f@;&.;\ c R PR R ITREFY NIRRTV R A
2 el e SYVRAF NS o e R iE B O N BT R 2 e B AR

PR ma R A o

H 3

[

EKP i% i BotMaster e77:% & fofir s 2] %> K- DzE € * dﬂz GRS N G
g i LUIS 03] chic 4« B 5.7 B- fod @& % ¥ L ATHCAI hd b

USER:
hi
BOT:
Uh huh
USER:
I like you
BOT
Sorry, | didn't get it. Which of following is your intent? 1. Ask the definition. 2 Search document on EKP. 0.None

USER:
0

BOT:
OK, note itl

USER:

I like you
BOT

Uh huh

B 5.7EKP § 37539 o

EKP iz q 8 B4 A 23 L Wang e €% "TUhhuh, F38 - &
Hit- B % 3R Tl like you ;> T H 3B B A 27 p EAER Sk ﬁ;@m
Foo R EAT R R Y KR ERU Ry # Y P LH 5 T None
o R TR EY ”“ﬁ‘ FEXMFEH o mFw Fit* F TOK, note

ith e v &g * § 4 - =ik Tllikeyou &> 8% 4 © gamg ig ;‘fm,g X
# "None ;> T+ % rUh huh | » B HFEERT EKP ok g B A 7 11 A&
FRPIERT o REFHEEE A 2 gt 2 LUIS 53] -
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6 Hu P T

AZWPE B AL RGP Fenfpr, & 72 BREGEE S ! Google
API ~ foe¢9 Amazon Web Service (AWS) APl % -

6.1 2 tfgF g

5 RE RS Y TR g AR S5 e s
i (ObjectModel) % #| F %'&mﬂ?ﬂf IR ANt xﬂp 1—’i%‘ri€§— £~ 2%
(DOCFIle) PR fdy R R T RE MR OT M B2 k-

¥ oo 4ri@] 6.1 AT o

ObjectModel

W

DocFile

B 6.1~ gkl
6.2 =¥ #! Google API

Google ft iir & i APL A5 4 # 4% 3 0 44| APL i€ * chi
R Google A% %7 ¥ 3 APIKey zgé%, %P & Mk eT v f BT T 2
HFEA[L0] -

~ & %1% :F Google # 3| - Web Service APl ¢ ¥ Google % 4 et i o
B 6.2 % b0 A5 " Request for information ;0 (5 i+ #1 Google API
w’w1ﬁloﬁﬁ§¢%m%¢%1o@ﬁﬂ*ﬁ_&mm,%ﬁ%ﬂﬁ

MRS T T2 T% TR S T& e T= ) B HEL R

*“ZF’;\'*E R URL A5G » ﬁi‘\'ﬁ T4-B) 6.3 #75F o
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UL YUy, — ALUICULY
String qry =| DataFO.toUrlFormat("Request for information“);l
URL url = new URL( RELLps://www.googleapis.com/customsearch/vl?key=" + key
+ "&cx=013036536707430787589:_pgjadShrlalg=" + gry + "&alt=json");
HttpURLConnection conn = (HttpURLConnection) url.openConnection();
conn.setRequestMethod("GET");
conn.setRequestProperty("Accept”, "application/json");
BufferedReader br = new BufferedReader(new InputStreamReader((conn.getInputSt

String output;
System.out.println("Output from Server .... \n");|
while ((output = br.readlLine()) != null) {

if (output.contains("\"link\": \"")) {
String link = output.substring(output.indexOf("\"link\": \"") + ("\"1
output.indexOf("\","));
System.out.println(link); // Will print the google search links

T s B Console 53 Problems Search Progress _ge Call Hierarchy AMWS Exr
<terminated > GoogleSearch.test [JUnit] C:\Java'jdk1.8.0_181\bin\javaw.exe (2018125308 FF11:06:19)
Output from Server ....

https://en.wikipedia.org/wiki/Request_for_information
https://www.performance.gov/GEARcenter/GEAR_Center_ RFI_amendment_8.28.20818.pdf
https://www.cftc.gov/sites/default/files/2018-12/federalregisterl21118.pdf
https://www.federalregister.gov/documents/2018/89/26/2018-28914/request-for-information-on-update
http://kl2education.gatesfoundation.org/researchanddevelopment/
https://www.federalregister.gov/documents/2018/12/14/2018-27162/request-for-information-on-modify
https://www.iup.edu/procurement/howto/request-for-information-(rfi)/
https://www.consumerfinance.gov/policy-compliance/notice-opportunities-comment/open-notices/reque
https://www.thebalancesmb.com/improve-request-information-process-845348
https://grants.nih.gov/grants/guide/notice-files/NOT-0D-18-134.html

B 6. 2 Google % 34 ;pa 1

/i EHTR OREESX EmAT

o+ URL 9 +SHTIERE %2B

/7 = URLAzeig Tl +S s %20
/1 AWRERRNTER %2F

/P AREFEMURLIDSE %3

[/ % iEemswm %29

fo# wTEREE %23

[/ & URL SisEefRmsme %26
// = URL hisESEEE  %3D

public static String toUrlFormat(String _str) {
if (_str == null)
return ""
return _str.replace("%", "%25").replace("+", "%2B").replace(" ", "%20").replace("/", "%2F")
.replace("?", "%3F").replace("#", "%23").replace("&", "%26").replace(”=", "%3D");

B 6. 3URL 5 g2
6.3 = =1 AWS API

AWS IF Rk 3% 7 & F 0 AP 5 %% LUIS f- Google i% i Web Service
17 R T AWS H B AR NS R 5 3 B VDL fov2.0 HuE A A
LA T o SN R T 6 4oW 6.4 577 0 TRl o kR ALK
T E ;\:;}'u ‘;},;\:)E_-éc PN —gF %‘Iﬁfﬂialv? % o

16



aws

g —
rednvent 2018 E& MRRAE B TR OfEEBMEEE  AWS Marketplace HEREE

BMEISAS OE 4uImE) - RS - [DEACEE

AR Java B9 AWS BEEEE(H

A AWS REERFIR Java £ AWS BIRSESHTRE FF. PR T
iERRES iB& AWS BBFE (2% Amazon S3, Amazon ECS, DynamoDB, AWS JEAARS Java v2.0 B AWS
e Lambda ) 18 Java API, SEISEEEAEEE. EEE— 7 ‘ BAEEEt » ‘
= TEIEGEE AWS Java BIUE. ERESFEITE. £ GitHub EU{EFREtE »
— AR Java v1 11 g3 AWS
mEEA ‘E' — BEEIEE(S »
. LJ — 7E GitHub BUSIFREHE »
BUS=RER
AFS» RRABESE  APIZH20> BIRASSTE | Aws Toolit or Ecipse > |
20» & £ GitHub EV{S/FsEHE »

API 3218 111 »
Bt/ Rism
111

Bl 6. 4 AWS sdk for Java( /& : https://aws.amazon.com/tw/sdk-for-java[11])

~E 289 i A Java 4254 ¢ @ * Amazon Comprehend f= Amazon

Translate % sy o 11T A &) Fé BHD
6.3.1 Amazon Comprehend

Amazon Comprehend £_AWS 3 & enp 283 3 AJZ PRI > foficdic & B en
LUIStp ¥ & - FF 1% ;’K”ﬁ # 2 ST F 8 (entity)fr 2 F iR (sentiment) 4 47
e LUIS g *t 3 &7 T & Rl(intent) ;<3g 8] > » Amazon Comprehend i § -
EKP g et ¢ o0 bt A RIZE hd re  RAeBAES 0 4 PR
EESE e TR AR 0T o 3 H EKP B f5E* LUIS (75 315 % 4
3B Pp RIET EIES 0K F) o B 6.5 - * Amazon Comprehend 1 ip]
M LS ol g bl o
DetectEntitiesRequest req = new DetectEntitiesRequest();
req.setlanguageCode("en"
System.out.println("req: + req);
String text = "The ohm egg is really tender, 4-5 points; "
+ "the rest of the chicken chops and tomato sauce fried corn ham rice pop.";
req = req.withText(text);]

System.out.println("--------------------- detect entitieg---------cc—ccoccoonn ");
DetectEntitiesResult result = cph.detectEntities(req);

List<Entity> entitylist = result.getEntities();
for (Entity e : entitylist) {
System.out.println(e.getText() + "\t" + e.getType() + "\t" + e.getScore() + "\t" + e.getBeginOffset!
+ e.getEndOffset());

DetectSentimentRequest dsRequest = new DetectSentimentRequest();
dsRequest.setLanguageCode("en");

dsRequest = dsRequest.withText(text);

System.out.println("-------------co-u--- detect sentiment--------------------- ");
DetectSentimentResult dsResult = cph.detectSentiment(dsRequest);
System.out.println(dsResult.getSentiment() + "\t" + dsResult.getSentimentScore());

B Console 52 ems og Ca 2ra J AWS Explc
<terminated > AwsTest testDetect [JUnit] C\)ava\jdk1 8.0_181\bin\javaw exe (20185125308 F511:37:53)
cph: com.amazonaws.services.comprehend.AmazonComprehendClient@23621559

reg: {languageCode: en}

————————————————————— detect entities---------------------

a4 QUANTITY 0.91207063 30 31

5 points QUANTITY 0.98267466 32 40

--------------------- detect sentiment---------------------

POSITIVE {Positive: ©.8792118,Negative: ©.0013215729,Neutral: @.114472575,Mixed: @.0049940757}

[ 6. 5 Amazon Comprehend # i
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6.3.2 Amazon Translate

Amazon Translate £_ AWS 3% & %R 7% > F (F4c@ 6.6 777 o

WK
i

@Test

public veoid testTranslate() {
AmazonTranslate translate = AmazonTranslateClientBuilder.defaultClient();
System.ouwt.println("translate: " + translate);

TranslateTextRequest reg = new TranslateTextRequest();
req.setSourceLanguageCode("zh-TW")
req.setTargetLanguageCode("en");
req.setText ("iEE—RFIEMEE-");

[V -

TranslateTextResult result = translate.translateText(req);
System.out.println("result.ge':Tr'anslatedText(): " + result.getTranslatedText());

BWN R OO0

Servers [E) Console 53 Problems Search Progress Call Hierarchy g JUnit AWS Explore

<terminated > AwsTest testTranslate [JUnit] C\Java'jdk1.8.0_181\bin\javaw.exe (20185125308 F511:32:52)
translate: com.amazonaws.sepui slateClient@10683d9d
result.getTranslatedText():|It is a tasty restaurant.

45 o

] 6. 6 Amazon Translate # i

6.4 *4c %}f@i‘l

e - B BN B BB (R ) e R R R
HEAT AL AT IR (b k) LA AR AR A
BT R koo EKP fBeie v F RAS R 0 de BASL o Y i
Sha-256 ;% & i+ o ¢ irihJava #2.58 #8 [12]fr2c % 4o 6.7 577 o

public static String getSHA256(String input) {

String toReturn = null;
try {
MessageDigest digest = MessageDigest.getInstance("SHA-256");
digest.reset();
digest.update(input.getBytes("utf8"));
toReturn = String.format("%@40x", new BigInteger(l, digest.digest()));
} catch (Exception e) {
e.printStackTrace();

¥
return toReturn;
| ResultGrid | TH 4% Fiter Rowss: | | Edit: g B B | Export/import: B K@) | wrep Cel Content: IR
uid id ssword name object_aeate_time object_update_tme

4 .UserZ user01 | aad415a73c4cef1ef94a5c00b2642b571a325494536328ad960dbe 18890d9368  |userDl  2018-12-30T14:22:08.010  2018-12-30T14:22:08.010

|USEI'3 userD2 | 76431fac8a187241af8f3f37156deb34732f52fb45eb07ec4f462051bd82f183 user02  2018-12-30T14:24:14.017  2018-12-30T14:24:14.017
o ]

] 6. 7 Java @ iT Sha-256 4c % /% & ;2
6.5 %% & AWS
Pl B R RN b AWS R i AT o
6.5.1 EC2

A& T Java gt 425 0 7 & A EC2% £ IDK > ¥R 2B Flc 4o
B 6.8 #7177

o



M [ Delete
I Local Disk (C:) » Java » jdiel.B.0 191 - & o
3 Cuick access
bin
B Desitep New
mclude
& Downloads jre =
Documents b
Dictiings COPYRIGHT nderw cwarShalli Brewit...
= Pictur YRIGHT
outstrag
ttdocs javafu-sre =
g LICENSE
B Thiz PC @ FEADME
B Desitop redease
Decuments e
4 Downloads THIRDPARTYLICENSEREADME
B Music THIRDPART YLICENSEREADME
= Pictures
v <€
12 tems

F16.8 & EC2 % % Java 3

oA BFAEC2 %% Tomeat PIRE » 3 EKP & & er3n
F A EC2 1 o 33 B Tomeat #'fR % i server.xml < 4 » 3= appBase 35 +
EKP & &7 enT Al & » i if 2 3% T 4B 6.9 -

B<!-
=
=]
=]
=] -- ~ » ThisPC { Local Disk (C app >
- p 2X Name
Valwve "org.apache.catalina.valves,AccessLogValve"
N s g oads EKP
="localhost_access_log" =".txt"
=n3h %1 %u %t &quot;ir&quot; %s %b" /> nents

"true" />

B 6.9 % EC2 } % % Tomcat % 3 {v EKP & %

6.5.2 RDS

e AWS 7 RDS P2 d e thenf & 0 T so AR il K 2 5
AWS 7 RDS - 4p B & & # B ®] 6. 10 #7o7 o

19



Connection Name: laws

Connection Remote Management System Profile

Connection Method: | Standard (TCP/IP) | Method to use to connect to the RDBMS

Parameters ss|. Advanced

Hostname: | |5106034303-edu-aws.cwtqr1-| rort: ‘3306 ‘Jh'i;nfmorpg:taddress of the server host - and
Username: |root l Name of the user to connect with.
Password: | Store in Vault ... | | Clear | lltasl.:ter's password. Wil be requested later if it's
Default Schema: ‘ The schema to use as default schema. Leave
blank to select it later.
v [ ekp_ec2
v @ Tables
> auth_usear
» = bid_fi
» doc_file
> mtn_keyword_def
> obj seq
Views
[ stored Procedures
5 Functions

) 6. 10 RDS % & # [®
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K Pl

i
o

AREEP BEAT] S % o
(AR 2 DR Y
PR AR SN APRERT R mE FR T - BRESTR

I3
T oo PEEREWEKTIRIEHAER -
7.2 Java {v Python T [ & i@

P nduER S Y n\ﬁﬁ Python 35> 4rfe A Java42;% @ =& ¢ Python
A28 € R isF R SURe- < FPEE o ¥ 0b > pow &% Tomcat ~ ZK ~ $52 Java
@ ERF s (554 7o ¥ e Djiango 457 Python 9 it T 22 i
ﬁ&ij.%?» 7 & 4 Jg Java fr Python /& i€ ¢hR* 4E -

7.3 391 B A JRIM =2

P EKP § (T8 BA W TAR 2@0E o N0 @
TR PRzzw SR T E R ORI E RIS € -
2t

S €& AT e
TA445 » BEEY N FREY B
AL ERABESY ARGV T LY PP

TAL P RFT I
BB EKP @Y bl T AH EFR B FRE TR A,
?’ pqor\‘l N S 7 'L"E%K'_é * vﬁ E] = Lﬁm’_ﬁ_/zﬁ@ LUIS 3 FJL{L( ‘?”iﬁ(entlty)o
Lt LMSH&@@&Téﬁvl PR B FRE RS Y e
P eTE e e mrgﬁ'*%J"i LA B 3 EPRFE o
742 < 2 247
Wk EKP ¢ g3 xR BT SEATEAE Y F
TR g B - < AR e

743 p BET A&

1
b
P
T+

™

P EKP f iEemsa B v RBR Y Femz o DASEH RiE3
@goﬁfﬁﬁﬁﬁmg#’QE%JT$@?%;%{Q%L%?Tm?
o R RGPLE 2 e h B F SN EBEREY R TP RET A
¢ Mg EFABE P F LA e

744 ¢ < 5

LUIS &t ikenp RFZ @ 6 * B2 > e &z =¥ 2 hp RES
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[1] https://zh.wikipedia.org/wiki/Java
[2] https://zh.wikipedia.org/wiki/Apache_Tomcat
[3] https://zh.wikipedia.org/wiki/ZK
[4] https://docs.microsoft.com/zh-tw/azure/cognitive-services/luis/what-is-luis
[5] https://www.newtype.com.tw
[6] http://new.lyserp.com.tw
[7] https://www.zkoss.org/download/zk
[8] http://tomcat.apache.org
[9] LUIS API https://westus.dev.cognitive.microsoft.com/docs/services
[10] Google API Key https://www.wfublog.com/2018/12/google-api-key-
activate-quota.html
[11] https://aws.amazon.com/tw/sdk-for-java
[12] https://stackoverflow.com/questions/5531455/how-to-hash-some-string-
with-sha256-in-java
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https://www.newtype.com.tw/
http://new.lyserp.com.tw/
https://www.zkoss.org/download/zk
http://tomcat.apache.org/
https://westus.dev.cognitive.microsoft.com/docs/services
https://www.wfublog.com/2018/12/google-api-key-activate-quota.html
https://www.wfublog.com/2018/12/google-api-key-activate-quota.html
https://aws.amazon.com/tw/sdk-for-java
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https://stackoverflow.com/questions/5531455/how-to-hash-some-string-with-sha256-in-java
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